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Q1: What are the four fundamental parts of computer? Explain it with 

the help of diagram. 

Input device:- an input device is a piece of equipment used to provide data 

and control signals to an information processing system such as a computer or 

information appliance. Examples of input devices include keyboards, mouse, 

scanners, [[digital camera]The]s, joysticks, and microphones. 

Central processing unit(CPU):-  central processing unit (CPU), also called 

a central processor, main processor or just processor, is the electronic 

circuitry within a computer that executes instructions that make up 

a computer program. The CPU performs basic arithmetic, logic, controlling, 

and input/output (I/O) operations specified by the instructions in the 

program. The computer industry used the term "central processing unit" as 

early as 1955. 

Primary Memory:- Primary memory is computer memory that is accessed 

directly by the CPU. This includes several types of memory, such as the 

processor cache and system ROM. However, in most cases, primary 

memory refers to system RAM. 

Output:- An output device is any piece of computer hardware equipment 

which converts information into human-readable form. It can be text, 

graphics, tactile, audio, and video. Some of the output devices are Visual 

Display Units i.e. a Monitor, Printer, Graphic Output devices, Plotters, Speakers 

etc. 

Q2: Discuss about the classification of computers based on size and 

capacity? 

Classification of computer based on size and capacity:- 

a)  Microcomputers(Personal Computer) 
A microcomputer is the smallest general purpose processing system. The 
older pc started 8 bit processor with speed of 3.7MB and current pc 64 bit 
processor with speed  of 4.66 GB. 
Examples: -     IBM PCs, APPLE computers 
 

https://en.wikipedia.org/wiki/Electronic_circuit
https://en.wikipedia.org/wiki/Electronic_circuit
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Instruction_(computing)
https://en.wikipedia.org/wiki/Computer_program
https://en.wikipedia.org/wiki/Arithmetic
https://en.wikipedia.org/wiki/Input/output


b)         Minicomputer: -         A minicomputer is a medium-sized computer. 
That is more powerful than a microcomputer. These computers are usually 
designed to serve multiple users simultaneously (Parallel Processing). They 
are more expensive than microcomputers. 
Examples:        Digital Alpha, Sun Ultra. 
 
c)         Mainframe computers: - Computers with large storage capacities and 
very high speed of processing (compared to mini- or microcomputers) are 
known as mainframe computers. They support a large number of terminals 
for simultaneous use by a number of users like ATM transactions. They are 
also used as central host computers in distributed data processing system. 
Examples: -     IBM 370, S/390. 
d)         Supercomputer: -      Supercomputers have extremely large storage 
capacity and computing speeds which are many times faster than other 
computers. A supercomputer is measured in terms of tens of millions 
Instructions per second (mips), an operation is made up of numerous 
instructions. The supercomputer is mainly used for large scale numerical 
problems in scientific and engineering disciplines such as Weather analysis. 
Examples: -     IBM Deep Blue 
 
 
Q3: What is the meaning of computer generation? How many Computer 

Generations are defined? What technologies were/are used? 

Generation in computer terminology is a change in technology 

a computer is/was being used. Initially, the generation term was used to 

distinguish between varying hardware technologies. 

Nowadays, generation includes both hardware and software, which together 

make up an entire computer system. 

The first integrated circuits contained only a few transistors and so were 

called “Small-Scale Integration (SSI). They used circuits containing transistors 

numbering in the tens. They were very crucial in development of early 

computers. SSI was followed by introduction of the devices which contained 

hundreds of transistors on each chip, and so were called “Medium-Scale 

Integration (MSI). 



MSI were attractive economically because which they cost little more systems 

to be produced using smaller circuit boards, less assembly work, and a 

number of other advantages.  

Microprocessor chips produced in 1994 contained more than three million 

transistors. ULSI refer to “Ultra-Large Scale Integration” and correspond to 

more than 1 million of transistors. However there is no qualitative leap 

between VLSI and ULSI, hence normally in technical texts the “VLSI” term 

cover ULSI. 

 

Q4: Differentiate between Volatile & Non- Volatile memories. 

s.no. Volatile memory Non volatile memory 

1. Volatile memory is the type of 
memory in which data is lost as 
it is powered-off. 

Non-volatile memory is the type of 
memory in which data remains 
stored even if it is powered-off. 

2. Contents of Volatile memory is 
stored temporarily. 

Contents of Non-volatile memory is 
stored permanently. 

3. It is faster than non-volatile 
memory. 

It is slower than volatile memory. 

4. RAM(Random Access 
Memory) is an example of 
volatile memory. 

ROM(Read Only Memory) is an 
example of non-volatile memory 

5. In volatile memory, data can be 
easily transferred in 
comparison to non-volatile 
memory. 

In non-volatile memory, data can not 
be easily transferred in comparison 
to volatile memory. 

6. In Volatile memory, process 
can read and write. 

In Non-volatile memory, process can 
only read. 



7. Volatile memory is more costly 
per unit size. 

Non-volatile memory is less costly 
per unit size. 

 

 

Q5: Distinguish among system software, application software and open 
source software on the basis of their features. 

System software:- System software is a type of computer program that is 
designed to run a computer's hardware and application programs. If we think 
of the computer system as a layered model, the system software is the 
interface between the hardware and user applications. 

Features of system software:- 

• System Software is closer to the system. 

• Generally written in a low-level language. 

• The system software is difficult to design and understand. 

• Fast in speed. 

• Less interactive. 

• Smaller in size. 

• Hard to manipulate 

 

Application software:- Application software is a program or group of 
programs designed for end users. Examples of an application include a word 
processor, a spreadsheet, an accounting application, a web browser, an email 
client, a media player, a file viewer, simulators, a console game or a photo 
editor. 

Feautures of application software:- 

• Perform more specialized tasks like word processing, spreadsheets, email, 
photo editing, etc. 

• It needs more storage space as it is bigger in size. 

• Easy to design and more interactive for the user. 



• Generally written in a high-level language. 

 

Open source software:- Open-source software is a type of computer software 
in which source code is released under a license in which the copyright holder 
grants users the rights to use, study, change, and distribute the software to 
anyone and for any purpose. Open-source software may be developed in a 
collaborative public manner. 

Features of open source software:- 

• Lesser hardware costs.  

• High-quality software.  

• No vendor lock-in.  

• Integrated management.  

• Simple license management.  

• Lower software costs.  

• Abundant support.  

• Scaling and consolidating. 

 

 

Q6. a) Create a file in MS-word to insert a paragraph about yourself and 
save it with file name “yourself”. Describe all steps involved in it. 

1. To open Microsoft Word, click on the Word icon ("W") on the toolbar or 
desktop. ... 

2. An open (and blank) Word document will open on the screen. 

3. Enter a paragraph about yourself. 

4. When document is finished, click on "File" on the standard toolbar at the top 
of screen. 

5. Click on "Save As." 

 

 

 



Q6 b) Write steps regarding followings   

• To change the font style  

• To change the font size 

• To change the font color 

•  To highlight (in yellow) the line that reads “need to get IMS’s address”. 

 

• Steps to change the font style:- 

• Go to Format > Font > Font. You can also press and hold. + D to 
open the Font dialog box. 

• Select the font and size you want to use. 

• Select Default, and then select Yes. 

• Select OK. 

 

• Steps to change the font size:- 

• Select the text or cells with text you want to change. To select all 
text in a Word document, press Ctrl + A. 

• On the Home tab, click the font size in the Font Size box. 

• Steps to change font color:- 

• Select the text that you want to change. 

• On the Home tab, in the Font group, choose the arrow next 
to Font Color, and then select a color. 

Q7. Create a file in MS-Word for the following document and save it with file 
name ‘ms_word’. Describe all steps involved in it. 

steps of create a file in ms word:- 

1. The Start button in the lower-left corner of your screen gives you access to 
all programs on your PC—Word included. To start Word: 

 choose Start → All Programs → Microsoft Office → Microsoft office word. 

2. and then enter the data  



MS WORD 

MS WORD is a widely used commercial word processor developed by 
microsoft. 

ms word is application software,which is capable of 

• creating, 

• editing, 

• saving and  

• printing and type of document 

When document is finished, click on "File" on the standard toolbar at the top 
of screen. 

Click on "Save As."option. 

and save this file name "ms word". 

 

Q8. Create a file in MS-word for the following document and save it with file 
name ‘equations’. Describe 

all steps involved in it. 

 

• Choose Insert > Equation and choose the equation you want from the 
gallery. 

• After you insert the equation the Equation Tools Design tab opens with 
symbols and structures that can be added to your equation. 

Q9. Create a file in MS-word that convert existing highlight text to table as 
shown below and save it as 

file name ‘text_to_table’. Describe all steps involved in it. 

Processs of converting text into table :- 

• Select the text that you want to convert, and then 
click Insert > Table > Convert Text to Table. 

• In the Convert Text to Table box, choose the options you want. 
• Under Table size, make sure the numbers match the numbers of 

columns and rows you want. 
• Under AutoFit behavior, choose how you want your table to look. 

Word automatically chooses a width for the table columns. If you want a 
different column width, choose one of these options. 



• Under Separate text at, choose the separator character you used in the 
text. 

• Click OK.  

Q10. Create a file in MS-Word to insert a table in the document. Describe all 
steps involved in it. 

1. Open a blank Word document. 

2. In the top ribbon, press Insert. 

3. Click on the Table button. 

4. Either use the diagram to select the number of columns and rows you need, or 
click Insert Table and a dialog box will appear where you can specify the 
number of columns and rows. 

5. The blank table will now appear on the page. 

 

Q11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

Roll no. Name marks 

1 N1 60 

2 N2 70 

3 N3 80 

4 N4 90 

5 N5 40 

6 N6 50 

7 N7 77 

8 N8 44 

9 N9 88 

10 N10 55 

 

 

Q13 a) Describe various steps involved in the following   

1. To modify column width of a worksheet 
2.  To modify the row height of a worksheet   
3. To delete rows and columns of a worksheet 

 



Ans:- 

1. Steps of modify column width of worksheet:- 
• Select the columns you want to modify. 
• Click the Format command on the Home tab. The format drop-

down menu appears. 
• Select Column Width. Increasing the column width. 
• The Column Width dialog box appears. Enter a specific 

measurement.  
• Click OK. 

 
2. Steps  of modify column height of a worksheet:- 

 
• Locate and click the Select All button just below the name box to 

select every cell in the worksheet. 
• Position the mouse over a row line so the cursor becomes a 

double arrow. 
• Click and drag the mouse to increase or decrease the row height, 

then release the mouse when you are satisfied. 
 

3. Steps of delete rows and column in worksheet:- 
 

• Right-click in a table cell, row, or column you want to delete. 
• On the menu, click Delete Cells. 
• To delete one cell, choose Shift cells left or Shift cells up. 

To delete the row, click Delete entire row. 
To delete the column, click Delete entire column. 

Q13 b) Describe following terms in the worksheet  

I. Absolute reference and relative reference in formula 
 
There are two types of 
cell references: relative and absolute. Relative and absolute 
references behave differently when copied and filled to other 
cells. Relative references change when a formula is copied to 
another cell. Absolute references, on the other hand, remain 
constant no matter where they are copied. 
 
 
 



II. Cell address 
Cell address, is an alphanumeric value used to identify a 
specific cell in a spreadsheet. Each cell reference contains one or 
more letters followed by a number. The letter or letters identify 
the column and the number represents the row. 

Q14. a) What tools are available to customize our PowerPoint presentation? 

               The tools are available to customize our PowerPoint presentation 
are:- 

• Perspector. Perspector is a tool used by designers to create 3D images on 
PowerPoint presentations. ... 

• PivotViewer. The Silverlight PivotViewer is yet another tool frequently used 
by PowerPoint presentation designers. ... 

• Autodesk 3DS Max. ... 

• VisualBee PowerPoint Add-In. ... 

• SmartArt. ... 

• Animations and Transitions. ... 

 

Q14 b) Write the steps for the following action for creation of power point 

presentation  

a. Open a Blank presentation 

Steps of open a blank a document:- 

• If you already have a file open in Word. 

• you can create a new document by clicking File>New.  

• You can also use the shortcut Ctrl+N (Command+N for Mac).  

• To open a blank document, double-click the blank 

document option. 

 

b. Save the presentation as Lab1.pptx. 

               Steps  to save the presentation :- 

• To save the presentation  go to the file . 

• Click on save as option. 

• And save the presentation giving the name “Lab1.pptx.” 



 

c. Add a Title to the first slide: the name of your college  

Steps of add a title to the slide:- 

•  Go to the first slide of presentation. 

• Add the title name “abc college”. 

• And save it by press “ctrl+s”. 

 

d. Type your first name and last name in the Subtitle section 

Steps of type first name and last name in the subtitle section. 

• There are many free software packages (such as Aegisub or 

Subtitle Workshop), that allow you to type in the subtitles 

yourself and lock them to a specific time code (e.g 00:45-00:51). 

There is a thing you should keep in mind – adding the subtitles 

manually is a very time-consuming process. Moreover, you will 

have to dedicate some time to learn the interface and shortcuts of 

the software of your choice. 

e. Add a New Slide which has a Title and Content. 

Steps of add a new slide:- 

• In the slide preview pane on the left, left-click with your mouse 
in-between two slides where you want to insert a slide. 

• In the PowerPoint Ribbon, on the Home or Insert tab, click 
the New Slide option. 

• In the drop-down menu that opens, select the type of slide to 
insert. 

Q15. Write steps for creation of a set of PowerPoint slides that demonstrates 

your skill to use the tools of PowerPoint. It should include the following things 

 Title slide &bullet list  Inserting Excel Sheet 

Clip art and Text 

Slide show effects 

• Click the Start button. 

• Click All Programs option from the menu. 



• Search for Microsoft Office from the sub menu and click it. 

• Search for Microsoft PowerPoint  from the submenu and click it. 

• Go to the “paragraph”icon and select the bullet where you want. 

• To insert clip art and text go to the insert tab and click on clip art and 

choose the picture you want to appear on page. 

• And then to slide show effect select all the slide and go to the “format 

“and select the slide show effect .and click on that. 

 
Q16. What is the difference between Machine Language and High Level 
Language? 
s.no. Machine language High level language 
1. It is a machine friendly 

language. 
It is programmer friendly language. 

2. machine language is high 
memory efficient. 

High level language is less memory 
efficient. 

3. It is tough to understand. It is easy to understand. 
4. It is complex to debug 

comparatively. 
It is simple to debug. 

5. It is complex to maintain 
comparatively. 

It is simple to maintain 

6. It is machine-dependent. It can run on any platform. 
7. It is non-portable. It is portable. 
 
Q17. Discuss about different data types of C programming Language? 
 
4 data types in C language  are:- 
• char: The most basic data type in C. It stores a single character and 

requires a single byte of memory in almost all compilers. 
• int: As the name suggests, an int variable is used to store an integer. 
• float: It is used to store decimal numbers (numbers with floating point 

value) with single precision. 
• double: It is used to store decimal numbers (numbers with floating point 

value) with double precision.  
 
 
 
 



Q18. Find the output of the following expressions? 
  

a) X=20/5*2+30-5 
 x=30 
 

b) Y=30 – (40/10+6) +10  
 y=30 
 

c) Z= 40*2/10-2+10  
Z=16 
 

Q19. Describe the syntax of the following statements? 
 

a) If – else statement syntax:- 
if (test expression)  
{ 
   // statements to be executed if the test expression is true 
} 
 

b) for loop- 
for (initializationStatement; testExpression; updateStatement) 
{ 
    // statements inside the body of loop 
} 

 
c) while loop 

Syntax 
while (condition test) 
{ 
      //Statements to be executed repeatedly  
      // Increment (++) or Decrement (--) Operation 
} 

 
d) Do-while loop - A do...while loop is similar to a while loop, except the 

fact that it is guaranteed to execute at least one time. 
 
while (testExpression)  
{ 
    // statements inside the body of the loop  



} 
Q20. Find the output of the following program segments? 

a b c 
#include <stdio.h>  
int main()  
{  
int i;  
for (i=1; i<2; i++)  
{  
printf( "IMS 
Ghaziabad\n");  
}  
}  
 
 
 

#include <stdio.h>  
int main()  
{  
int i = 1;  
while ( i <= 2 )  
{  
printf( "IMS 
Ghaziabad\n");  
i = i + 1;  
}  
}  

 #include <stdio.h>  
void main()  
{  
int a = 10, b=100;  
if( a > b )  
printf( "Largest number 
is %d\n”, a);  
else  
printf( "Largest number 
is %d\n”, b);  
} 

  
IMS Ghaziabad   

IMS Ghaziabad 

IMS Ghaziabad 

 

Compilation failed due 
to following error(s). 
 

main.c: In function ‘main
’: 

main.c:14:9: warning: m
issing terminating " char
acter 

 printf( "Largest number
 is %d\n”, a); 
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Q1.   What are the different types of networks? 

ANS:-  Types of network:- 

  1 LAN (LOCAL AREA NETWORK) 

                     

A Local Area Network (LAN) is a group of computer and peripheral devices 

which are connected in a limited area such as school, laboratory, home, and 

office building. It is a widely useful network for sharing resources like files, 

printers, games, and other application. The simplest type of LAN network is to 

connect computers and a printer in someone's home or office. In general, LAN 

will be used as one type of transmission medium.      

 
2  WAN (WIDE AREA NETWORK) 
         

               
 



WAN Wide Area Network is another important computer network that 

which is spread across a large geographical area. WAN network system could 

be a connection of a LAN which connects with other LAN's using telephone 

lines and radio waves. It is mostly limited to an enterprise or an organization. 

3 MAN (Metropolitan Area Network) 

            

A Metropolitan Area Network or MAN is consisting of a computer network 

across an entire city, college campus, or a small region. This type of network is 

large than a LAN, which is mostly limited to a single building or site. 

Depending upon the type of configuration, this type of network allows you to 

cover an area from several miles to tens of miles. 

4 PAN  (PERSONAL AREA NETWORK) 

           

PAN is a computer network formed around a person. It generally consists of a 

computer, mobile, or personal digital assistant. PAN can be used for 



establishing communication among these personal devices for connecting to a 

digital network and the internet. 

Q2.    Explain the Shielded twisted pair (STP) and Unshielded twisted 

pair(UTP). 

ANS:  STP (SHIELDEDE TWISTED PAIR) 

              

Shielded twisted pair (STP) cable was originally designed by IBM for token 

ring networks that include two individual wires covered with a foil shielding, 

which prevents electromagnetic interference, thereby transporting data 

faster. 

 UTP (UNSHIELDED TWISTED PAIR) 

                       

 

UTP stands for Unshielded Twisted Pair cable. UTP cable is a 100 ohm 

copper cable that consists of 2 to 1800 unshielded twisted pairs surrounded by 

an outer jacket. They have no metallic shield. This makes the cable small in 

diameter but unprotected against electrical interference. 

 



 Q3.  What is difference between baseband and broadband transmission? 

ANS:  

s.no. Baseband transmission Broadband transmission 
1. In baseband transmission, the 

type of signalling used is analog. 
In broadband transmission, the 
type of signalling used is digital 

2. It is used with a bus as well as 
tree topology. 

It works well with bus topology. 

3. Only PSK encoding is used. In broadband transmission, 
Manchester and Differential 
Manchester encoding are used. 

4. Signals can be travelled over long 
distances without being 
attenuated. 

Signals can only travel over short 
distances. 

5. Baseband Transmission is 
unidirectional in nature. 

Broadband Transmission is 
bidirectional in nature. 

 

Q.4 What is the difference between a hub, modem, router and a switch? 

ANS:- computers, network devices or other networks are required to be 
connected, hubs, switches and routers are the bridges to link them together. 
All the three types of devices can perform the same function, and technicians 
sometimes may use the terms interchangeably. However, this will make people 
confuse whether they are the same thing or different from each other. This 
post is going to explore the actual meanings of hub, switch, router and what 
they are used for. 

• HUB  

A hub is to sent out a message from one port to other ports. For example, 
if there are three computers of A, B, C, the message sent by a hub for 
computer A will also come to the other computers. But only computer A 
will respond and the response will also go out to every other port on the 
hub. Therefore, all the computers can receive the message and 
computers themselves need to decide whether to accept the message. 

https://www.fs.com/c/enterprise-network-911


                       

 

• SWITCH 

A switch is able to handle the data and knows the specific addresses to 
send the message. It can decide which computer is the message intended 
for and send the message directly to the right computer. The efficiency of 
switch has been greatly improved, thus providing a faster network 
speed. 

       

• ROUTER 

Router is actually a small computer that can be programmed to handle 
and route the network traffic. It usually connects at least two networks 
together, such as two LANs, two WANs or a LAN and its ISP network. 
Routers can calculate the best route for sending data and communicate 
with each other by protocols. 

  



   

 

• MODEM 

  a portmanteau of "modulator-demodulator" – is a hardware device that 

converts data from a digital format, intended for communication 

directly between devices with specialized wiring, into one suitable for 

a transmission medium such as telephone lines or radio. A 

modem modulates one or more carrier wave signals to encode digital 

information for transmission, and demodulates signals to decode the 

transmitted information. The goal is to produce a signal that can be 

transmitted easily and decoded reliably to reproduce the original digital 

data. 

         

 

https://en.wikipedia.org/wiki/Portmanteau
https://en.wikipedia.org/wiki/Computer_hardware
https://en.wikipedia.org/wiki/Transmission_medium
https://en.wikipedia.org/wiki/Modulation#Digital_modulation_methods
https://en.wikipedia.org/wiki/Carrier_wave
https://en.wikipedia.org/wiki/Digital_information
https://en.wikipedia.org/wiki/Digital_information
https://en.wikipedia.org/wiki/Demodulation
https://en.wikipedia.org/wiki/Signal_(electronics)


Q. 5   When you move the NIC cards from one PC to another PC, does the 

MAC address gets transferred as well? 

Ans:  Yes, that's because MAC addresses are hard-wired into 

the NIC circuitry, not the PC. 

 

Q.6 When troubleshooting computer network problems, what 

common hardware-related problems can occur? 

Ans:  Most common hardware related problems are PaBX, LAN Card, 

WLAN Card and Wi-Fi AP if it is wireless, Cables, Switches, Routers and 

Wireless Controllers. 

 

Q.7 In a network that contains two servers and twenty 

workstations, where is the best place to install an Anti-virus 

program? 

Ans: The best solution is to install anti-virus on all the computers in the 

network. This will protect each device from the other in case some 

malicious user tries to insert a virus into the servers or legitimate users. 

 

Q.8 . Define Static IP and Dynamic IP? Discuss the difference 

between IPV4 and IPV6. 

Ans: STATIC IP: 

                      A static IP address is simply an address that doesn't change. 

Once your device is assigned a static IP address, that number typically 

stays the same until the device is decommissioned or your network 

architecture changes. Static IP addresses generally are used by servers 

or other important equipment. 

 

        DYNAMIC IP: 

                    A dynamic IP address is an IP address that changes from time 

to time unlike a static IP address. Most home networks are likely to have 

a dynamic IP address and the reason for this is because it is cost 

effective for Internet Service Providers (ISP's) to allocate dynamic 

IP addresses to their customers 



                   

 

 

the difference between IPV4 and IPV6:- 

     

IPV4   IPV6  

IPv4 has 32-bit address length   IPv6 has 128-bit address length  

It Supports Manual and DHCP 
address configuration 

  It supports Auto and renumbering 
address configuration 

 

In IPv4 end to end connection 
integrity is Unachievable 

  In IPv6 end to end connection integrity is 
Achievable 

 

It can generate 4.29×109 
address space 

  Address space of IPv6 is quite large it can 
produce 3.4×1038 address space 

 

Security feature is dependent on 
application 

  IPSEC is inbuilt security feature in the 
IPv6 protocol 

 

Address representation of IPv4 
in decimal 

  Address Representation of IPv6 is in 
hexadecimal 

 

Fragmentation performed by 
Sender and forwarding routers 

  In IPv6 fragmentation performed only by 
sender 

 

In IPv4 Packet flow 
identification is not available 

  In IPv6 packetflow identification are 
Available and uses flow label field in the 

header 

 

In IPv4 checksumfield is 
available 

  
In IPv6 checksumfield is not available 

 

It has broadcast Message 
Transmission Scheme 

  In IPv6 multicast and any cast message 
transmission scheme is available 

 

In IPv4 Encryption and 
Authentication facility not 

provided 

  
In IPv6 Encryption and Authentication 

are provided 

 



IPv4 has header of 20-60 bytes.   IPv6 has header of 40 bytes fixe  

 
                       

Q.9 . Discuss TCP/IP model in detail. 

Ans: TCP/IP model 
                                 The TCP/IP Reference Model. TCP/IP means Transmission 

Control Protocol and Internet Protocol. It is the network model used in the 

current Internet architecture as well. ... These protocols describe the 

movement of data between the source and destination or the internet. 

• The TCP/IP model was developed prior to the OSI model. 

• The TCP/IP model is not exactly similar to the OSI model. 

• The TCP/IP model consists of five layers: the application layer, 
transport layer, network layer, data link layer and physical layer. 

• The first four layers provide physical standards, network interface, 
internetworking, and transport functions that correspond to the first 
four layers of the OSI model and these four layers are represented in 
TCP/IP model by a single layer called the application layer. 

• TCP/IP is a hierarchical protocol made up of interactive modules, and 
each of them provides specific functionality. 

 

Q.10 What is a Web Browser (Browser)? Give some example of 
browsers 

ANS: A web browser is a software application for accessing information 
on the World Wide Web. When a user requests a web page from a 
particular website, the web browser retrieves the necessary content 
from a web server and then displays the page on the user's device 

Example of browsers:- 

         1 Internet Explorer, 

         2 Mozilla Firefox,  



         3 Google Chrome  

          4  Opera. 

 

   

11. What is a search engine? Give example. 

A search engine is a web-based tool that enables users to locate information 
on the World Wide Web. Popular examples of search engines are Google, 
Yahoo!, and MSN Search. Search engines utilize automated software 
applications (referred to as robots, bots, or spiders) that travel along the Web, 
following links from page to page, site to site. The information gathered by the 
spiders is used to create a searchable index of the Web.  

1. Bing 

2. DuckDuckGo 

3. Wiki.com 

4. Ecosia 

5. Yahoo! 

6. Swisscows 

7. CC Search 

8. Gibiru 

9. Qwant 

10. Yandex 

11. Disconnect 

12. Ask 

12. What is the Internet & WWW? What are the uses of internet in our 

daily life? 

Internet:-The Internet is a vast network that connects computers all over the 

world. Through the Internet, people can share information and communicate 

from anywhere with an Internet connection. 



 

WWW:-The World Wide Web, commonly known as the Web, is an information 

system where documents and other web resources are identified by Uniform 

Resource Locators, which may be interlinked by hypertext, and are accessible 

over the Internet.  

 

• Uses of the Internet in Education. ... 

• Internet Use to Speed Up Daily Tasks. ... 

• Use of the Internet for Shopping. ... 

• Internet for Research & Development. ... 

• Digital Transactions. ... 

• Money Management. 

 

13. What is an Internet Service Provider? Give some example of ISP in 
India. 

 

An Internet service provider (ISP) is an organization that provides services for 
accessing, using, or participating in the Internet. Internet service providers 
can be organised in various forms, such as commercial, community-
owned, non-profit, or otherwise privately owned. 

Internet services typically provided by ISPs can include Internet 
access, Internet transit, domain name registration, web 
hosting, Usenet service, and colocation. 

An ISP typically serves as the access point or the gateway that provides a user, 
access to everything available on the Internet.  

Example of ISP in india:- 

• Jio 

• Airtel 

• Vodafon 

• Idea 

• Bsnl 

• Mtnl. 

https://en.wikipedia.org/wiki/Internet
https://en.wikipedia.org/wiki/Community-owned
https://en.wikipedia.org/wiki/Community-owned
https://en.wikipedia.org/wiki/Non-profit
https://en.wikipedia.org/wiki/Privately_owned
https://en.wikipedia.org/wiki/Internet_access
https://en.wikipedia.org/wiki/Internet_access
https://en.wikipedia.org/wiki/Transit_(Internet)
https://en.wikipedia.org/wiki/Domain_name
https://en.wikipedia.org/wiki/Web_hosting_service
https://en.wikipedia.org/wiki/Web_hosting_service
https://en.wikipedia.org/wiki/Usenet
https://en.wikipedia.org/wiki/Colocation_centre
https://en.wikipedia.org/wiki/Internet_access
https://en.wikipedia.org/wiki/Default_gateway


 

14. Discuss the difference between MAC address, IP address and Port 

address. 

MAC Address:-A media access control address is a unique identifier assigned 

to a network interface controller for use as a network address in 

communications within a network segment. This use is common in most IEEE 

802 networking technologies, including Ethernet, Wi-Fi, and Bluetooth.  

 

IP address:- An Internet Protocol address is a numerical label assigned to 

each device connected to a computer network that uses the Internet Protocol 

for communication. An IP address serves two main functions: host or network 

interface identification and location addressing. 

 

Port address:- in computer networking, a port is a communication endpoint. 

At the software level, within an operating system, a port is a logical construct 

that identifies a specific process or a type of network service. 

15. How do we view my Internet browser's history? 

In a Microsoft Edge browser window, open the history menu using the 
keyboard shortcut Ctrl+H. You can also access this menu with the following 
steps: 

1. Click the Hub   button in the upper right-hand corner of the window. 
2. Click the History   icon to open the history menu. 

This menu allows you to view the pages you've visited in chronological order. 
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1. Elaborate the process & elements of Communication in detail through 

suitable examples. 

Communication process as such must be considered a continuous and 

dynamic inter-action, both affecting and being affected by many variables. 

(1) Sender: 

The person who intends to convey the message with the intention of passing 

information and ideas to others is known as sender or communicator. 

(2) Ideas: 

This is the subject matter of the communication. This may be an opinion, 

attitude, feelings, views, orders, or suggestions. 

(3) Encoding: 

Since the subject matter of communication is theoretical and intangible, its 

further passing requires use of certain symbols such as words, actions or 

pictures etc. Conversion of subject matter into these symbols is the process of 

encoding. 

(4) Communication Channel: 

The person who is interested in communicating has to choose the channel for 

sending the required information, ideas etc. This information is transmitted to 

the receiver through certain channels which may be either formal or informal. 

(5) Receiver: 

Receiver is the person who receives the message or for whom the message is 

meant for. It is the receiver who tries to understand the message in the best 

possible manner in achieving the desired objectives. 



(6) Decoding: 

The person who receives the message or symbol from the communicator tries 

to convert the same in such a way so that he may extract its meaning to his 

complete understanding. 

(7) Feedback: 

Feedback is the process of ensuring that the receiver has received the 

message and understood in the same sense as sender meant it. 
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Q1. Write html and css for the following using div 

For header and footer 

 
<! DOCTYPE html> 
<html lang="en"> 
<head> 
<title>CSS Template</title> 
<meta charset="utf-8"> 
<meta name="viewport" content="width=device-width, initial-scale=1"> 
<style> 
* { 
  box-sizing: border-box; 
} 
 
body { 
  font-family: Arial, Helvetica, sans-serif; 
} 
 
/* Style the header */ 
header { 
  background-color: #666; 
  padding: 30px; 
  text-align: center; 
  font-size: 35px; 
  color: white; 
} 
 
/* Create two columns/boxes that floats next to each other */ 
nav { 
  float: left; 
  width: 30%; 
  height: 300px; /* only for demonstration, should be removed */ 
  background: #ccc; 
  padding: 20px; 
} 
 
/* Style the list inside the menu */ 
nav ul { 



  list-style-type: none; 
  padding: 0; 
} 
 
article { 
  float: left; 
  padding: 20px; 
  width: 70%; 
  background-color: #f1f1f1; 
  height: 300px; /* only for demonstration, should be removed */ 
} 
 
/* Clear floats after the columns */ 
section:after { 
  content: ""; 
  display: table; 
  clear: both; 
} 
 
/* Style the footer */ 
footer { 
  background-color: #777; 
  padding: 10px; 
  text-align: center; 
  color: white; 
} 
 
/* Responsive layout - makes the two columns/boxes stack on top of each 
other instead of next to each other, on small screens */ 
@media (max-width: 600px) { 
  nav, article { 
    width: 100%; 
    height: auto; 
  } 
} 
</style> 
</head> 
<body> 
 



<h2>CSS Layout Float</h2> 
<p>In this example, we have created a header, two columns/boxes and a 
footer. On smaller screens, the columns will stack on top of each other.</p> 
<p>Resize the browser window to see the responsive effect (you will learn 
more about this in our next chapter - HTML Responsive.)</p> 
 
<header> 
  <h2>Cities</h2> 
</header> 
 
<section> 
  <nav> 
    <ul> 
      <li><a href="#">London</a></li> 
      <li><a href="#">Paris</a></li> 
      <li><a href="#">Tokyo</a></li> 
    </ul> 
  </nav> 
   
  <article> 
    <h1>switzerland </h1> 
    <p>Switzerland is a mountainous Central European country, home to 
numerous lakes, villages and the high peaks of the Alps. Its cities contain 
medieval quarters, with landmarks like capital Bern’s Zytglogge clock tower 
and Lucerne’s wooden chapel bridge. The country is also known for its ski 
resorts and hiking trails. Banking and finance are key industries, and Swiss 
watches and chocolate are world renowned.</p> 
    <p>The amazing mountains, heaps of lakes and beautiful villages make for 
the most beautiful scenery in Switzerland. These landscapes are considered 
to be what makes Switzerland the perfect destination for vacationing and 
exploring new cultures. The high-peak Alps and mountains make up to 62% of 
the country's territory..</p> 
  </article> 
</section> 
 
<footer> 
  <p>Footer</p> 
</footer> 
 



</body> 
</html> 
 

For navigation 

 
<!DOCTYPE html> 
<html> 
<title>csc accadmy</title> 
<meta name="viewport" content="width=device-width, initial-scale=1"> 
<link rel="stylesheet" href="https://www.cscacademy.org/"> 
<body> 
 
<div class="csc accadmy"> 
  <h2>Navigation Bars</h2> 
  <p>The <strong>csc-bar</strong> class is a container for displaying HTML 
elements horizontally.</p> 
  <p>The <strong>csc-bar-item</strong> class defines the container 
elements.</p> 
  <p>It it a perfect tool for creating navigation bars:</p> 
</div> 
 
<div class="w3-bar w3-black"> 
  <a href="#" class="https://www.cscacademy.org/overview">Home</a> 
  <a href="#" class="https://www.cscacademy.org/governing-body">page 
1</a> 
  <a href="#" class="https://www.cscacademy.org/vision">page 2</a> 
  <a href="#" class="https://www.cscacademy.org/smart-class">page 3</a> 
</div> 
 
</body> 
</html> 

For content:- 

 

HTML 



<div class="shadowbox"> 
  <p>Here's a very interesting note displayed in a 
  lovely shadowed box.</p> 
</div> 

CSS 

.shadowbox { 
  width: 15em; 
  border: 1px solid #333; 
  box-shadow: 8px 8px 5px #444; 
  padding: 8px 12px; 
  background-image: linear-gradient(180deg, #fff, #ddd 40%, #ccc); 
} 

 
 

For Sidebar 

Step 1) Add HTML: 

<!-- Side navigation --> 

<div class="sidenav"> 

  <a href="#">About</a> 

  <a href="#">Contact</a> 

  <a href="#">Clients</a> 

  <a href="#">home</a> 

</div> 

 



<!-- Page content --> 

<div class="main"> 

  ... 

</div> 

Step 2) Add CSS: 

/* The sidebar menu */ 

.sidenav { 

  height: 100%; /* Full-height: remove this if you want "auto" height */ 

  width: 160px; /* Set the width of the sidebar */ 

  position: fixed; /* Fixed Sidebar (stay in place on scroll) */ 

  z-index: 1; /* Stay on top */ 

  top: 0; /* Stay at the top */ 

  left: 0; 

  background-color: #111; /* Black */ 

  overflow-x: hidden; /* Disable horizontal scroll */ 

  padding-top: 20px; 

} 

 

/* The navigation menu links */ 

.sidenav a { 

  padding: 6px 8px 6px 16px; 

  text-decoration: none; 

  font-size: 25px; 

  color: #818181; 

  display: block; 

} 

 

/* When you mouse over the navigation links, change their color */ 

.sidenav a:hover { 

  color: #f1f1f1; 

} 



 

/* Style page content */ 

.main { 

  margin-left: 160px; /* Same as the width of the sidebar */ 

  padding: 0px 10px; 

} 

 

/* On smaller screens, where height is less than 450px, change the style of the 

sidebar (less padding and a smaller font size) */ 

@media screen and (max-height: 450px) { 

  .sidenav {padding-top: 15px;} 

  .sidenav a {font-size: 18px;} 

} 

 
Q3. Write a Program to display count, from 5 to 15 using PHP loop as 
given below.  
 
<?php 
$count = 5; 
while($count <= 15) 
{ 
  echo $count; 
  echo "<br>" ; 
 
  $count++; 
} 
?> 

 
 Q4. Write a program in javascript for Unit Conversion from Kilometer 

(km) to Centimeter (cm). use of message box is necessary . 

<!DOCTYPE html> 

<html> 

<title>kilometrs to cm Length Converter</title> 



<body> 

 

<h2>Length Converter</h2> 

<p>Type a value in the kilometers field to convert the value to cm:</p> 

 

<p> 

  <label>killometers</label> 

  <input id="inputcm" type="number" placeholder="killometers" 

oninput="LengthConverter(this.value)" 

onchange="LengthConverter(this.value)"> 

</p> 

<p>cm: <span id="output cm"></span></p> 

 

<script> 

function LengthConverter(valNum) { 

  document.getElementById("output cm").innerHTML=valNum/100000; 

} 

</script> 

</body> 

</html 

 

 

 


